
6105 Windows Server og datanett © Jon Kvisli, USN Nettverkskomponenter - 1

6105 Windows Server og datanett

Leksjon 10b Nettverkskomponenter del 2
– ICMP-protokollen

– Adresseoversetting – NAT (noe repetisjon)

– NAT i VirtualBox og VMware

– Portviderekobling (Port Forwarding)

– Portviderekobling (Port Forwarding) i VirtualBox, VMware
og hjemmeruter

Pensum:

– Kvisli: Datakommunikasjon og maskinvare, 

kapittel 3 TCP/IP protokollene

– Kvisli: Datakommunikasjon og maskinvare, 

kapittel 4 Nettverkskomponenter

Linker:
– Det finnes mye stoff om dette på Wikipedia: Søk på begrepene
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ICMP protokollen
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Figuren er hentet fra Frode Sørensen: Innføring i nettverk, IDG Books Norge

ICMP brukes for å sende kontrollmeldinger i IP-nett

ICMP pakker pakkes inn med IP-hode og transporteres av IP

Likevel regnes vanligvis ICMP som en lag 3 protokoll (ikke lag 4)
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ICMP protokollen

ICMP = Internet Control Message Protocol

– Transportprotokoll for feilmeldinger og annen kontrollinformasjon i nettet

– Brukes primært av rutere og andre nettkomponenter

– Brukes også for å sende ”testmeldinger” i nettet, f.eks. av ping

– Definerer et stort antall meldingstyper

Mye brukte meldingstyper:

Echo Request Ber om svar fra en maskin (brukes av ping)

Echo Reply Svarer på Echo Request

Timestamp Request Måler tiden ICMP pakken bruker

Timestamp Reply Svarer på Timestamp Request

Router Advertisement Routere informerer om sin eksistens og adresse

Destination Unreachable Mottakers IP-adresse kan ikke nås

Time Exceeded Telleren Time-to-live i en IP pakke har nådd 0

Source Quench Flaskehals har oppstått i ruter eller mottaker
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ICMP og ping

Kommandoen ping bruker ICMP meldinger

– Sender en Echo Request melding

– Mottar en  Echo Reply melding

Eksempel:  ping www.usn.no

Responstiden er den tiden det tar å få svar på en ping

– Måles i millisekunder (ms)

– Skyldes hovedsaklig forsinkelser (latency) i hver av ruterne på veien
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ICMP og traceroute
Traceroute bruker flere ICMP meldinger etter hverandre

– øker begrensning i antall hopp (Time-To-Live) for hver melding

– måler dermed responstiden til hver av ruterne på vegen til mottaker

Eksempel: tracert www.usn.no
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Private IP-adresser (repetisjon)

Reserverte adresseområder Nettverk Kommentar   

10.0.0.0 - 10.255.255.255 10.0.0.0/8 224 adresser

172.16.0.0 - 172.31.255.255 172.16.0.0/12 220 adresser

192.168.0.0 - 192.168.255.255 192.168.0.0/16 216 adresser

169.254.0.0 - 169.254.255.255 169.254.0.0/16 (Automatisk privat IP-adr.)

Private IP-adresser skal ikke brukes på Internett
– Dvs. ikke på maskiner/nettkort som er knyttet direkte til Internett

– Private IP-adresser videresendes ikke av rutere i Internett !

Beregnet for bruk i "lukkede" IP-nett
– IP-nett som er ”gjemt” bak en ruter, og ”usynlige” for Internett.

– Ruteren gjør adresseoversetting  (NAT) for pakkene rutes ut på Internett.

– Private IP-nett er ”usynlige” for hverandre – unngår adressekonflikt med 

    like private adresser

– Private IP-adresser kan brukes "fritt" av alle. 

Hvorfor?
– "Sparer" offentlige (offisielle) adresser på maskiner som ikke har behov for det.

– Har begrenset problemet med for få adresser i IP versjon 4
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Adresseoversetting – NAT (repetisjon)

LAN
Private adresser

192.168.52.0/24

192.168.52.2 158.64.2.75
Privat IP-adresse offentlig IP-adresse
på ”innsiden” på ”yttersiden”

Fra: 192.168.52.51

Til: 128.39.198.44

Fra: 158.64.2.75

Til: 128.39.198.44

Klient

Fra: 128.39.198.44

Til: 158.64.2.75

Fra: 128.39.198.44

Til: 192.168.52.51

Figuren er modifisert fra Frode Sørensen: Innføring i nettverk, IDG Books Norge
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Adresseoversetting – NAT (repetisjon)

Problemstilling:

– Ruter mellom internt nett og åpent Internett med offentlige (offisielle) adresser

– Ønsker å bruke private IP-adresser i internt nett

– Private IP-adresser må ikke slippe ut på Internett!

Løsning: NAT – Network Address Translation

– Ruter har én offentlig (offisiell) IP-adresse på ”yttersiden”

– Ruter oversetter private IP-adresser til sin offentlige (offisielle) IP-adresse

– Kun ruterens offentlige (offisielle) adresse er ”synlig” på Internett

Detaljer:

– Ruter endrer avsenderadresse på alle utgående IP pakker, til sin egen offentlige IP-adresse.

» Fra ”ytre nett” (Internet) ser det ut som om alle IP-pakker kommer fra ruteren!

– Alle innkommene IP-pakker vil ha ruterens offentlige IP-adresse som mottakeradresse

– Ruteren endrer mottakeradresse til riktig privat IP-adresse, før pakken sendes inn i LAN’et

– NAT kan også benyttes med flere offentlige IP-adresser på yttersiden



6105 Windows Server og datanett © Jon Kvisli, USN Nettverkskomponenter -  9

NAT bruker portoversetting

• For hver klient tildeler ruteren 

nye portnumre på yttersiden

• Ruteren endrer avsenders 

portnr i TCP/UDP-hodet i tillegg 

til IP-adressen i IP-hodet

LAN
Private IP-adresser

192.168.52.0/24

Offentlig

IP-adresse

158.64.2.75

Internett

192.168.52.51

192.168.52.52

192.168.52.52

192.168.52.53

49151

49151

46152

49151

Privat side

adresse port

158.64.2.75

158.64.2.75

158.64.2.75

158.64.2.75

49151

49152

49153

49154

Offentlig side

adresse port

Klient 1

192.168.52.51

Klient 2

192.168.52.52

Klient 3

192.168.52.53

Tjener

Figuren er modifisert fra Frode Sørensen: Innføring i nettverk, IDG Books Norge

Offentlige IP-adresser

Tjener



6105 Windows Server og datanett © Jon Kvisli, USN Nettverkskomponenter -  10

NAT bruker portoversetting

PAT – Port Address Translation 

– Ruteren lagrer en tilstandstabell med alle portnummer og tilhørende private IP-adresse/portnr på innsiden

– Må brukes når NAT-ruteren kun har én offentlig (offisiell) IP-adresse på utsiden.

– Alle private socketadresser over-settes til en entydig offentlig  socket-adresse.

– Hvert portnr på yttersiden tilsvarer én socketadresse på innsiden.

Fordeler/hensikter med PAT

– Flere maskiner kan dele én felles offentlig (offisiell) IP-adresse

» Reduserer behovet for offentlige IP-adresser

– Skjuler interne IP-adresser for tilgang fra ytre nett 

» gir en viss form for sikkerhet, hindrer etablering av forbindelser fra utsiden

Ulemper med PAT

– Kommunikasjonen må initieres fra innsiden

» Klienter i ytre nett kan ikke kontakte tjenere i LAN’et (ingen info i tilstandstabellen)

» Dette kan løses med port forwardning (se neste foil)

– Forbindelsesfrie protokoller som UDP krever spesiell behandling

» Ruteren må reservere portnummeret i PAT-tabellen en viss tid for det kan gjenbrukes.

– Enkelte protokoller/applikasjoner vil fungere dårlig

» De som benytter varierende portnummer (f.eks. FTP, Oracle Net)

» IP-tunnellering (VPN / IPsec)

NAT’ing er også en 

sikkerhetsmekanisme
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NAT i VirtualBox
Definere virtuelt lokalnett med NAT

– Menyvalg: File → Tools → Network Manager

– Fanen NAT Networks

– Angi nettadresse og maskelengde (IPv4 Prefix)

– DHCP-tjener i VB kan aktiveres/deaktiveres

» VB velger DHCP-adresser (scope) automatisk ut 
fra IPv4 Prefix'et som du oppgir for NAT-nettet.

.1 er adresse til ruteren i VB 
(som er default gateway i NAT-nettet)

.2 er adresse til DNS tjeneren i VB

Koble virtuell maskin til NAT-nettet

– Menyvalg: Machine → Settings → Network

– Plasser nettkortet (Adapter 1) i NAT-nettet

– VM’ene kan få IP-adresse manuelt (statisk) eller 
fra DHCP-tjener i VirtualBox
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NAT i VMware Workstation

Definere virtuelt lokalnett med NAT

– Menyvalg: Edit → Virtual Network Editor

» Knappen Change Settings

– Lokalnettet VMNet8 er definert som NAT-nett

– Du kan konfigurere:

» Nettadresse (Subnet IP)

» Subnettmaske (Subnet mask) 

• definerer adresseområde for NAT-nettet

Under NAT Settings kan du velge

– IP-adresse for ruteren i VMware (Gateway IP)

» Blir default ruter i NAT-nettet

– Under DNS Settings:

» IP-adresser til DNS-tjenere

» Blir delt ut av DHCP til klienter i NAT-nettet
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NAT i VMware Fusion

Definere virtuelt lokalnett med NAT

– Menyvalg: VMware Fusion → Settings

– Fanen Network

– Valget Share with my Mac definerer det virtuelle 
lokalnettet som et NAT-nett

– Konfigurasjon for NAT kan ikke endres i programmet

Konfigurasjon for NAT-nettet kan endres i 
konfigurasjonsfiler. Se neste side.

Koble virtuell maskin til NAT-nettet

– Menyvalg: Virtual Machine → Network Adapter

– Velg NAT
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NAT i VMware Fusion

Tekstfiler for å endre konfigurasjon for NAT-nettet i WMware Fusion

Obs! Vit hva du gjør før du endrer disse! :-)

– Konfigurasjon av virtuelle nett i filen:
/Library/Preferences/VMware Fusion/networking

» Nettadresse (ip) og subnettmaske (netmask)

» IP-adresse for VMware (host IP)

– Konfigurasjon av NAT-nettet vmnet8 i filen:
/Library/Preferences/VMware Fusion/vmnet8/nat.conf

» Nettadresse (ip) og subnettmaske (netmask)

» IP-adresse for VMware (host IP)

– Konfigurasjon av DHCP-tjener for NAT-nettet
vmnet8 i filen:
/Library/Preferences/VMware Fusion/vmnet8/dhcp.conf

» Nettadresse (subnet) og subnettmaske (netmask)

» DNS-servere (domain-name-servers)

» IP-adresse for default ruter (routers)

# NAT gateway address
ip = 172.16.152.2
netmask = 255.255.255.0
# VMnet device if not specified on command line
device = vmnet8
# VMnet host IP address
hostIp = 172.16.152.1

subnet 172.16.152.0 netmask 255.255.255.0 {
range 172.16.152.128 172.16.152.254;
option broadcast-address 172.16.152.255;
option domain-name-servers 172.16.152.2;
option domain-name localdomain;
default-lease-time 1800;      # default is 30 minutes
max-lease-time 7200;          # default is 2 hours
option netbios-name-servers 172.16.152.2;
option routers 172.16.152.2;

}

VERSION=1,0
answer VNET_8_DHCP yes
answer VNET_8_DHCP_CFG_HASH 8F0B8949DE17E207E9487E80EC39609CA18CC261
answer VNET_8_HOSTONLY_NETMASK 255.255.255.0
answer VNET_8_HOSTONLY_SUBNET 172.16.152.0
answer VNET_8_HOSTONLY_UUID D410D508-1C36-460B-862A-E09AD2AEBB18
answer VNET_8_NAT yes
answer VNET_8_VIRTUAL_ADAPTER yes
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NAT i hjemmeruter

Eksempel: Typisk hjemmeruter fra Altibox (Zyxel Modell VMG v2)

– Kan konfigurere siste del av IP-adresse for lokalnettet og adresseområde for DHCP

– Offentlig IP-adresse på yttersiden er bestemt av ISPen

– DNS-adresser er også styrt av ISPen
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Portviderekobling (Port Forwarding) 
gir tilgang fra utsiden

LAN
Private adresser

192.168.52.0/24

Offentlig IP-adresse

158.64.2.75

Internett

Klient

192.168.52.53

Web-tjener 1

192.168.52.10:80

Figuren er modifisert fra Frode Sørensen: Innføring i nettverk, IDG Books Norge

Offentlige adresser

Klient

Klient

192.168.52.10

192.168.52.10

192.168.52.12

192.168.52.12

80

443

80

443

Privat side

adresse port

158.64.2.75

158.64.2.75

158.64.2.75

158.64.2.75

80

443

81

444

Offentlig side

adresse port

Web-tjener 2

192.168.52.12:80

192.168.52.12 3389 158.64.2.75 3389
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Portviderekobling (Port Forwarding) 
gir tilgang fra utsiden

Problem:

– Hva om vi ønsker å nå en tjener i indre nett, fra en klient utenfor?

– Vanlig NAT tillater ikke TCP/UDP trafikk som initieres utenfra

» Fordi de private IP-adressene er skjult for maskiner i ytre nett

» Fordi ruteren ikke kan vite hvilken indre adresse man ønsker å nå

Løsning: Portviderekobling (Port Forwarding)

– Ruteren kan lagre en tabell over hvilke IP-adresser+portnr som skal nås utenfra

» Tabellen må konfigureres manuellt i ruteren!

– Klienter i ytre nett kontakter ruterens IP-adresse, som om den var tjeneren

– Ruter videresender pakker til riktig privat IP-adresse i LANet.

Eksempel: Webtjener i indre nett skal kunne nås utenfra

– Webtjeners private socketadresse: 192.168.52.10:80

– Ruters offentlige (offisielle) IP-adresse på utsiden: 158.64.2.75

– Ruter lagrer følgende videresendingsinformasjon: 158.64.2.75:80 →192.168.52.10:80

– Klienter i ytre nett kontakter 158.64.2.75:80

– Ruter videresender pakkene til 192.168.52.10:80
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Port Forwarding i VirtualBox

Defineres i Network Manager

– Menyvalg: File → Tools → Network Manager

– Fanen Port Forwarding under NAT Networks

– Bruk +knappen (Add port forwarding rule) for å lage
nye videresendingsregler

For hver videresendingsregel definerer du:

– Navn på regelen (Name)

– Transportprotokoll i pakker fra ytre nett (Protocol)

– IP-adresse (Host IP) og portnummer (Host Port) i pakker fra ytre nett

» 0.0.0.0 betyr alle IP-adresser i ytre nett

– IP-adressen som pakken skal videresendes til i indre nett (Guest IP)

– Portnummeret som pakken skal videresendes til i indre nett (Guest Port)
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Port Forwarding i VMware Workstation

Defineres i NAT Settings

– Menyvalg: Edit → Virtual Network Editor

» Knappen Change Settings

» Knappen NAT-Settings...

– Bruk knappen Add for å lage nye videresendingsregler

For hver videresendingsregel definerer du:

– Portnummer i pakker fra ytre nett (Host port)
(IP-adressen er alltid ruterens ytre adresse)

– Transportprotokoll i pakker fra ytre nett (Type)

– IP-adressen som pakken skal videresendes til i 
indre nett (Virtual machine IP address)

– Portnummeret som pakken skal videresendes til i
indre nett (Virtual machine port)

– Navn på regelen (Description)
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Port Forwarding i VMware Fusion

Kan defineres i konfigurasjonsfilen for NAT-nettet 

– Rediger filen: /Library/Preferences/VMware Fusion/vmnet8/nat.conf

» Obs! Vit hva du gjør før du endrer denne! :-)

– Filen inneholder en seksjon for hver transportprotokoll i pakker fra ytre nett:

» [incomingtcp]

» [incomingudp]

For hver videresendingsregel definerer du:

– Portnummer i pakker fra ytre nett (external port number)
(IP-adressen er alltid ruterens ytre adresse)

– IP-adressen som pakken skal videresendes til i indre nett (VM's IP address)

– Portnummeret som pakken skal videresendes til i indre nett (VM's port number)

[incomingtcp]
# Use these with care - anyone can enter into your VM through these...
# The format and example are as follows:
#<external port number> = <VM's IP address>:<VM's port number>
80 = 192.168.52.10:80
443 = 192.168.52.10:443

[incomingudp]
# UDP port forwarding example
6000 = 192.168.52.10::6000
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Port Forwarding i hjemmeruter

De fleste "hjemmerutere" har mulighet for portvideresending

– Men noen internettleverandører begrenser muligheten for å konfigurere dette selv

Eksempel: MikroTik hjemmeruter

– Her kalles portvideresending for Port Mapping
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